
COMPUTER 
ARCHITECTURE

SECTION 

10
Year 1Engineering



2

COMPUTER ARCHITECTURESECTION10

AUTOMATION AND EMBEDDED SYSTEMS
Embedded Systems

Introduction
This section will introduce you to three different computer architectures used in 
the design of computer processors, which are: Complex Instruction Set Computer 
(CISC), Reduced Instruction Set Computer (RISC) and Advanced Reduced Instruction 
Set Computer (ARISC). Each of these architectures has distinct characteristics that 
affect how instructions are executed and how the processor operates. Also, you will 
be introduced to Random Access Memory (RAM) and Read-Only Memory (ROM), 
two distinct types of computer memory with different use cases. You will understand 
and appreciate Arduino and its application. Arduino was created to provide a 
straightforward way for beginners and enthusiasts to build very practical projects 
and solve real world problems. This section will also introduce you to an Integrated 
Development Environment (IDE) for writing, compiling, and uploading code to these 
boards.

At the end of this section, you will be able to: 

•	 Learners should describe the CISC, RISC and ARISC architectures
•	 Specify use cases for RAM/ROM.
•	 Learners should describe the memory architectures of RAM and ROM
•	 Install and configure the environmental variables of the Arduino IDE and interface with 

the Arduino hardware successfully

Key Ideas

•	 CISC, RISC, and ARISC are the three different computer architecture paradigms 
used in the design of computer processors and each of these architectures has distinct 
characteristics that affect how instructions are executed and how the processor operates.

•	 Arduino is an open-source platform consisting of hardware and software components 
created to provide an uncomplicated way for beginners and enthusiasts to create 
interactive electronic projects.

•	 Microcontrollers are small, integrated circuits that contain a processor, memory, and 
input/output pins that are designed to perform specific tasks and are commonly used in 
various applications, such as robotics, automation, home electronics, wearable devices 
etc.
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CISC, RISC AND ARISC ARCHITECTURES
CISC, RISC, and ARISC are three different computer architecture paradigms used in the 
design of computer processors. Each of these architectures has distinct characteristics 
that affect how instructions are executed and how the processor operates. Here is a 
brief description of each:

1. CISC (Complex Instruction Set Computer):
This is a type of computer architecture that features a large set of instructions, allowing 
for a wide range of operations to be performed with a single instruction. This contrasts 
with Reduced Instruction Set Computer (RISC) architectures, which use a smaller set 
of instructions. CISC architectures are designed to execute complex instructions in a 
single machine cycle, aiming to simplify the programming and improve performance 
by reducing the number of instructions needed to perform a task.

Advantages of CISC Architectures:
a.	 Reduced Programme Size: Because complex instructions can perform 

multiple operations, CISC processors can reduce the number of instructions 
needed for a programme, potentially decreasing the overall programme size.

b.	 Ease of Programming: The availability of high-level instructions simplifies 
the programming process and can lead to more efficient code generation.

c.	 Efficient Use of Memory: With fewer instructions required to perform a 
task, CISC architectures can be more memory-efficient, which is beneficial for 
systems with limited memory resources.

d.	 Compatibility: Many legacy systems use CISC architectures, so modern CISC 
processors often maintain backward compatibility with older software and 
instructions.

e.	 Complex Operations: CISC processors can execute complex operations 
directly, which can be advantageous for certain types of applications that require 
sophisticated operations.

Limitations of CISC Architectures:
a.	 Complex Instruction Decoding: The decoding process for CISC instructions 

can be complex and time-consuming, potentially impacting overall performance.
b.	 Variable Instruction Timing: Due to the variability in instruction length and 

complexity, the execution time for instructions can vary, making performance 
prediction and optimisation more challenging.

c.	 Microcode Overhead: Microcode used to implement complex instructions can 
introduce additional overhead and potentially reduce performance compared 
with simpler RISC architectures.

d.	 Increased Hardware Complexity: The support for many instructions and 
addressing modes can increase the complexity of the processor’s hardware 
design.
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e.	 Inefficiency for Simple Tasks: While CISC architectures excel in handling 
complex instructions, they may be less efficient for simple, repetitive tasks 
compared with RISC architectures.

Examples of CISC Architectures:
a.	 Intel x86 Family: The x86 architecture, used in many personal computers and 

servers, is one of the most well-known CISC architectures. It features a broad 
set of instructions and supports complex operations.

b.	 IBM System/360 and System/370: These mainframe architectures are 
examples of early CISC designs that were used in large-scale computing 
environments.

c.	 DEC VAX (Virtual Address eXtension): The VAX architecture is another 
example of a CISC processor, known for its extensive instruction set and 
complex operations.

Common examples of CISC architectures include x86 and x86-64 (Intel and AMD 
processors).

In summary, CISC architectures offer a rich set of instructions and high-level operations 
that can simplify programming and improve memory efficiency. However, they also 
face challenges related to instruction decoding complexity and performance variability. 
Understanding these characteristics helps in selecting the appropriate architecture for 
specific applications and designing systems that balance performance, complexity, and 
efficiency.

2. RISC (Reduced Instruction Set Computer):
This is a type of computer architecture that emphasises a simplified set of instructions, 
each designed to execute in a single clock cycle. This approach contrasts with Complex 
Instruction Set Computer (CISC) architectures, which feature a broader range of more 
complex instructions. RISC architectures are designed to streamline the execution of 
instructions, aiming for higher performance through simplicity and efficiency.

Advantages of RISC Architectures:
a.	 Increased Performance: The simplified instruction set, and single-cycle 

execution help to achieve higher performance, especially when combined with 
pipelining.

b.	 Efficient Pipelining: The uniform instruction format and consistent execution 
times enhance the efficiency of pipelining, leading to better overall throughput.

c.	 Reduced Instruction Decoding Complexity: With a smaller and simpler 
instruction set, the process of decoding instructions is less complex, reducing 
the overhead associated with instruction processing.

d.	 Consistent Execution Time: Most instructions are carried out in a single 
cycle, providing predictable and consistent execution times.

e.	 Enhanced Compiler Optimisation: The simplicity of the instruction set 
allows compilers to generate more efficient code, optimising performance and 
making better use of available resources.
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f.	 Scalability: The RISC architecture’s simplicity and regularity make it easier 
to scale and adapt for different applications, including embedded systems and 
high-performance computing.

g.	 Power Efficiency: The reduced complexity of the instruction set, and the 
efficiency of single-cycle operations can contribute to lower power consumption.

Limitations of RISC Architectures:
a.	 Increased Code Size: The need to use more instructions to perform complex 

tasks can lead to larger code sizes compared with CISC architectures, which 
have more complex instructions that can accomplish multiple tasks in a single 
instruction.

b.	 More Register Usage: RISC architectures rely heavily on registers for 
operations, which can lead to increased register pressure and may require more 
registers to be used effectively.

c.	 Complexity in Handling High-Level Operations: Some high-level 
operations may require multiple RISC instructions to accomplish, potentially 
making certain programming tasks more complex.

d.	 Limited Direct Memory Operations: The load/store architecture restricts 
direct memory operations, which may require additional instructions for tasks 
involving memory access.

e.	 Compiler Dependency: The effectiveness of RISC architectures can depend 
on the ability of the compiler to generate efficient code. Poorly optimised 
compilers may not fully leverage the benefits of the RISC design.

Examples of RISC Architectures:
a.	 ARM (Advanced RISC Machine): ARM processors are widely used in mobile 

devices, embedded systems, and increasingly in other areas like servers and 
high-performance computing. ARM is known for its efficiency and scalability.

b.	 MIPS (Microprocessor without Interlocked Pipeline Stages): MIPS 
processors are used in various applications, including embedded systems, 
network equipment, and academic research.

c.	 PowerPC: PowerPC processors, developed by IBM, Motorola, and Apple, are 
used in various applications, including embedded systems, gaming consoles, 
and previously in some desktop computers.

d.	 SPARC (Scalable Processor Architecture): Developed by Sun Microsystems, 
SPARC processors are used in high-performance computing and enterprise 
servers.
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3. ARISC (Advanced Reduced Instruction Set Computer):
This refers to a more advanced or enhanced version of the traditional Reduced 
Instruction Set Computer (RISC) architecture. While “ARISC” is not a widely 
recognised or standardised term in the industry, it typically denotes RISC architectures 
that have evolved with additional features and optimisations to improve performance 
and efficiency. These enhancements often incorporate advanced techniques and 
technologies that build on the principles of RISC design. ARISC architecture is a more 
recent development that combines elements of both CISC and RISC. ARISC processors 
are designed to be energy-efficient and suitable for a wide range of applications, 
including mobile devices and embedded systems.

Advantages of ARISC Architectures:
a.	 Higher Performance: Advanced features like out-of-order execution and 

branch prediction can significantly enhance performance compared with 
traditional RISC architectures.

b.	 Improved Efficiency: Optimisations in pipelining, cache design, and 
speculative execution contribute to better overall efficiency and resource 
utilisation.

c.	 Flexibility: Enhanced instruction sets, and advanced capabilities provide 
flexibility for handling a wider range of applications and workloads.

d.	 Scalability: ARISC architectures can scale effectively to meet the demands of 
high-performance computing environments and complex applications.

e.	 Better Multithreading Support: Support for simultaneous multi-threading 
and efficient thread management improves performance in multi-threaded 
applications.

Limitations of ARISC Architectures:
a.	 Increased Complexity: The additional features and optimisations introduce 

increased complexity in both hardware design and software development.
b.	 Higher Power Consumption: Advanced features such as speculative execution 

and out-of-order processing may lead to higher power consumption compared 
with simpler RISC designs.

c.	 Cost of Development: Developing and manufacturing processors with 
advanced features can be more costly, potentially increasing the cost of ARISC-
based systems.

d.	 Compatibility Issues: Introducing new instructions or features may lead to 
compatibility issues with existing software or legacy systems.

e.	 Potential Overhead: The overhead associated with advanced features like 
branch prediction and speculative execution may not always translate into 
proportional performance gains for all types of workloads.
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Examples of Advanced RISC Architectures:
a.	 ARM Cortex-A Series: The ARM Cortex-A series includes advanced features 

like out-of-order execution, SIMD, and branch prediction, demonstrating the 
evolution of RISC into more advanced architectures.

b.	 IBM POWER Series: IBM’s POWER processors, used in high-performance 
computing and enterprise servers, incorporate advanced RISC features such as 
out-of-order execution and SMT.

c.	 MIPS R-Series: The MIPS R-Series processors include enhancements for 
performance and efficiency, featuring advanced pipeline designs and support 
for vector processing.

Advancements and Future Trends
Advancements include multi-core processors (multiple processing units on a single 
chip), heterogeneous architectures (combining several types of processing cores), and 
specialised accelerators for specific tasks (like GPUs and AI accelerators). The future 
might see more emphasis on energy-efficient designs, novel memory hierarchies, and 
tighter integration with emerging technologies like quantum computing.

CISC: 
a.	 Intel Core series processors, which utilise complex instructions to optimise 

general-purpose computing tasks.
b.	 Modern CISC Processors: Modern CISC processors, such as those in the 

x86 family, have incorporated many features from RISC designs, including 
pipelining, out-of-order execution, and multiple execution units, to improve 
performance.

c.	 Hybrid Designs: Some modern processors use a hybrid approach, combining 
elements of both CISC and RISC architectures to leverage the strengths of both 
designs.

d.	 Performance Optimisation: Advances in microarchitecture, such as 
speculative execution and branch prediction, have been employed to enhance 
the performance of CISC processors and mitigate some of the limitations 
associated with complex instruction decoding.

RISC: 
a.	 ARM Cortex processors, known for their power-efficient design, are commonly 

used in mobile devices and embedded systems.
b.	 Integration with Modern Technologies: RISC architectures have integrated 

with modern technologies, including support for advanced features like out-
of-order execution, branch prediction, and SIMD (Single Instruction, Multiple 
Data) instructions.

c.	 Cross-Platform Compatibility: RISC processors are increasingly used in 
diverse computing environments, from mobile devices and embedded systems 
to data centres and supercomputers.
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d.	 Energy Efficiency: RISC architectures continue to focus on energy efficiency, 
particularly in mobile and embedded applications where power consumption 
is critical.

e.	 Hybrid Designs: Some modern processors use hybrid designs that combine 
elements of both RISC and CISC architectures to leverage the advantages of 
each approach.

ARISC: 
a.	 The Tensilica Xtensa processors provide configurable architectures for various 

application domains, allowing for tailored performance and efficiency trade-
offs.

b.	 Enhanced Multi-Core Designs: ARISC processors are increasingly adopting 
multi-core designs to improve parallel processing capabilities and overall 
performance. Modern ARM Cortex-A processors and IBM POWER series 
processors feature multiple cores with sophisticated inter-core communication 
and load balancing.

c.	 Improved Pipeline and Out-of-Order Execution: Advances in pipelining 
techniques and out-of-order execution are being used to further enhance 
instruction throughput and reduce execution latency. Advanced branch 
prediction and speculative execution techniques are being integrated to 
minimise pipeline stalls.

USES OF CISC, RISC AND ARISC 
ARCHITECTURES
Random Access Memory (RAM) and Read-Only Memory (ROM) are two distinct types 
of computer memory with different use cases. Here are some common use cases for 
both RAM and ROM:

RAM (Random Access Memory) is a type of volatile computer memory that 
temporarily stores data and programmes currently in use by a computer. Its key function 
is to provide quick read and write access to the CPU, making it a crucial component for 
system performance and multitasking.

Use Cases for RAM (Random Access Memory)
1.	 Temporary Data Storage: RAM is used to temporarily store data that the computer 

is actively using. This includes the data currently being processed by the CPU, open 
applications, and the operating system.

2.	 Running Applications: RAM stores the executable code and data of running 
applications. The more RAM a computer has, the more applications it can run 
simultaneously without slowing down.
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3.	 Caching: RAM is used to cache frequently accessed data from slower storage 
devices (like hard drives or SSDs) to improve system performance. This can include 
web page data, frequently used files, and more.

4.	 Virtual Memory: When the RAM is insufficient for the tasks at hand, the operating 
system can use a portion of the hard drive or SSD as virtual memory. This allows 
the computer to continue running, although at a slower pace.

5.	 Gaming: Many modern video games require substantial amounts of RAM to store 
textures, game assets, and other data for smooth gameplay.

6.	 Video and Image Editing: Applications like Adobe Photoshop and video editing 
software use RAM to store and manipulate large files and complex multimedia data.

7.	 Multitasking: RAM allows a computer to switch between tasks and applications 
quickly. More RAM means smoother multitasking.

8.	 Database Management: Database servers use RAM to cache frequently requested 
data, resulting in faster database query responses.

Types of RAM:
a.	 SRAM (Static RAM):

•	 SRAM uses flip-flop circuits to store each bit of data.
•	 It is faster and more reliable but more expensive and uses more power.
•	 Commonly used in cache memory due to its speed.

b.	 DRAM (Dynamic RAM):

•	 DRAM stores each bit of data in a tiny capacitor that needs constant 
refreshing to retain the data.

•	 It is slower than SRAM but cheaper and consumes less space, making it the 
most common type used for main memory in computers.

Types of DRAM:
DDR (Double Data Rate) RAM: A faster type of DRAM that transfers data on both 
the rising and falling edges of the clock signal. Examples include DDR3, DDR4, and 
DDR5, with each version being faster and more power-efficient than the previous one.

Functions of RAM:
a.	 Multitasking: RAM allows computers to run multiple applications 

simultaneously by providing temporary storage for active data from all 
programmes, so the CPU can switch between tasks quickly.

b.	 System Performance: The more RAM a system has, the more data it can 
handle at once, improving system performance, particularly for memory-
intensive tasks such as gaming, video editing, and software development.

c.	 Temporary Data Storage: When a programme or file is opened, it is loaded 
into RAM. Once the programme is closed, the data is removed from RAM. This 
allows for fast access to data when needed but ensures no memory is wasted 
when not in use.
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Importance of RAM:
a.	 Speed and Responsiveness: More RAM allows computers to handle larger 

files, run more applications simultaneously, and switch between them more 
fluidly, improving overall system responsiveness.

b.	 Multimedia and Gaming: Tasks like video rendering, gaming, and 3D 
modelling require large amounts of RAM to store textures, game states, or 
editing data for quick access by the CPU and GPU.

c.	 Web Browsing: Modern web browsers can use significant amounts of RAM, 
particularly when multiple tabs are open. Each tab stores its data in RAM to 
provide a smoother browsing experience.

ROM (Read-Only Memory) is a type of non-volatile memory that permanently 
stores data and instructions required by a computer or electronic device. Unlike 
RAM (Random Access Memory), which is temporary and volatile, ROM retains 
its contents even when the power is turned off, making it essential for storing critical 
system data, such as the firmware, boot loaders, and other vital instructions that must 
be preserved between uses.

Use Cases for ROM (Read-Only Memory)
1.	 Firmware: ROM is used to store firmware, which contains low-level software that 

initialises hardware components at boot time. Examples include BIOS or UEFI 
firmware in computers and firmware in embedded systems like game consoles or 
smart appliances.

2.	 Operating System Bootloader: ROM may contain the bootloader that is 
responsible for loading the operating system from storage devices like hard drives 
or SSDs.

3.	 Embedded Systems: In many embedded systems (e.g., car navigation systems, 
digital cameras, and microwave ovens), ROM stores the software necessary for their 
operation, ensuring that it remains unaltered.

4.	 Game Consoles: ROM cartridges or game discs used in older game consoles store 
game data, and the game console’s ROM contains essential software.

5.	 Mobile Phones: ROM in mobile devices often contains the phone’s operating 
system and system recovery software.

6.	 Security: Some ROM chips store cryptographic keys or security-related information 
that should not be altered or tampered with.

7.	 Medical Devices: ROM in medical equipment often stores the software needed for 
its functionality and regulatory compliance.
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Types of ROM:
a.	 Masked ROM (MROM):

•	 This is the original form of ROM, where the data is permanently written 
during the manufacturing process.

•	 The contents of MROM cannot be changed once created, making it cost-
effective for large-scale production but inflexible for updates.

b.	 PROM (Programmable ROM):
•	 PROM is a type of ROM that can be programmed once after the 

manufacturing process.
•	 Special devices called programmers are used to write data to PROM, and 

once programmed, the data cannot be altered.

c.	 EPROM (Erasable Programmable ROM):
•	 EPROM can be erased and reprogrammed multiple times. The data can be 

erased by exposing the EPROM chip to ultraviolet (UV) light.
•	 After erasing, the chip can be reprogrammed with new data. However, this 

process is time-consuming and requires special equipment.

d.	 EEPROM (Electrically Erasable Programmable ROM):
•	 EEPROM allows for erasing and reprogramming electrically, without 

needing UV light.
•	 Unlike EPROM, EEPROM can be erased and written to while the device is 

still in use, although it is still slower than other types of memory like RAM.
•	 EEPROM is commonly used for tasks where small amounts of data need to 

be saved and modified, like storing configuration settings.

e.	 Flash Memory:
•	 A modern type of EEPROM that allows for faster erasing and writing. Flash 

memory can erase and write large blocks of data at once, making it faster 
and more efficient.

Advantages of ROM:
a.	 Permanence: Since ROM is non-volatile, it ensures that critical data, like 

firmware or the system’s boot programme, is never lost or altered unintentionally.
b.	 Security: Because ROM is read-only (or very difficult to modify), it is highly 

secure from accidental or malicious changes. This makes it ideal for storing 
system-level instructions.

c.	 Reliability: ROM is reliable for long-term storage of essential data. The data 
is embedded during manufacturing or programmed in a way that is difficult to 
alter, making it robust for devices that need consistent functionality.

d.	 Cost-Effective for Mass Production: For devices produced in large quantities 
with a fixed set of instructions (e.g., calculators, controllers), using ROM is a 
cost-effective solution because it does not require rewritable storage.
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Disadvantages of ROM:
a.	 Inflexibility: Traditional ROM cannot be modified or updated after the initial 

writing, which makes it inflexible for situations where updates or patches may 
be necessary.

b.	 Slower than RAM: ROM is slower to access compared with RAM, which 
is optimised for speed. However, since ROM is not used for tasks requiring 
frequent or rapid data access, this is usually acceptable.

c.	 Limited Storage Capacity: ROM typically has a lower storage capacity 
compared with other types of memory, as it is used for storing essential, 
unchanging instructions rather than large datasets or applications.

Activity 10.1

1.	 Form a group of five with your classmates.
2.	 Discuss the concept of instruction pipelines in computer architectures. 

Discuss how pipelining improves execution efficiency and reduces latency. 
Explore how CISC and RISC architectures implement pipelines differently.

3.	 Discuss a scenario where an ARISC architecture could be advantageous over 
both CISC and RISC.

4.	 Discuss how ARISC architecture strikes a balance between CISC and RISC 
characteristics.

Activity 10.2

Exploring RISC vs. CISC Architectures

Topic: Hands-On Exploration of RISC and CISC Architectures

Objectives:

1.	 To understand the fundamental differences between RISC (Reduced 
Instruction Set Computer) and CISC (Complex Instruction Set Computer) 
architectures through a practical exercise.

2.	 To observe how instruction set design impacts programme complexity and 
execution.

3.	 To develop an appreciation for design choices in computer architecture.

Materials Needed:

1.	 Printed Instruction Set Guides: Basic Instruction sets for RISC and CISC 
architecture (Sample is provided below)

2.	 Graph Paper or Blank Sheets
3.	 Pens/Pencils
4.	 Optional Computers or Tablets for using online simulators
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Steps:

1.	 Read the printed guides to understand the basic principles of RISC and CISC 
architectures.

2.	 Form a group of five with your classmates. 
3.	 Design a simple programme to add two numbers and store the result using 

CISC architecture. 
4.	 Design a simple programme to add two numbers and store the result using 

RISC architecture.
5.	 Manually trace the execution of their programme step-by-step. Count each 

instruction used for the RISC architecture and note its impact. Track how 
complex instructions are executed and their impact.

6.	 Use graph paper or blank sheets to document the number of instructions, 
steps taken, and any observations about the complexity of each programme.

7.	 Groups exchange their findings and compare the results. Focus on the 
differences in instruction count, execution steps, and overall complexity.

Discussion Questions:

1.	 How many instructions did you use in your RISC programme compared 
with the CISC programme?

2.	 What observations did you make about the execution steps for RISC vs. 
CISC?

3.	 How did the complexity of the instructions impact the design of your 
programme?

4.	 What are the potential advantages of using RISC architecture based on your 
findings?

5.	 What are the potential benefits of CISC architecture despite its complexity?
6.	 How might the choice between RISC and CISC architectures influence 

software development?
7.	 In your group analyse the instruction sets of both CISC and RISC 

architectures to identify common instructions, addressing modes, and data 
types. Compare the complexity of instructions in each architecture.

8.	 Explore performance metrics such as CPI (Cycles Per Instruction) and 
IPC (Instructions Per Cycle). Calculate these metrics for representative 
instructions in CISC and RISC architectures.

Printed Instruction Guide for RISC and CISC

1.	 RISC Architecture

Key Characteristics:
a.	 Simplicity: A small set of simple instructions.
b.	 Uniformity: Instructions typically execute in one clock cycle.
c.	 Load/Store Model: Operations are performed between registers and 

memory.
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Example Instructions:

a.	 ADD R1, R2, R3
•	 Description: Adds the contents of registers R2 and R3 and stores 

the result in register R1.
•	 Operation: R1 = R2 + R3

b.	 SUB R4, R5, R6
•	 Description: Subtracts the contents of register R6 from register R5 

and stores the result in register R4.
•	 Operation: R4 = R5 − R6

c.	 LOAD R1, 1000(R2)
•	 Description: Loads the value from memory address (1000 + R2) 

into register R1.
•	 Operation: R1 = Memory [1000 + R2]

d.	 STORE R1, 2000(R2)
•	 Description: Stores the value from register R1 into memory address 

(2000 + R2).
•	 Operation: Memory [2000 + R2] = R1

Sample Programme:

Objective: Add two numbers stored in memory and store the result back in 
memory.

Instructions:
a.	 LOAD R1, 1000 (Load value from memory address 1000 into R1)
b.	 LOAD R2, 1004 (Load value from memory address 1004 into R2)
c.	 ADD R3, R1, R2 (Add R1 and R2, store result in R3)
d.	 STORE R3, 1008 (Store result from R3 into memory address 1008)

5.	 CISC Architecture

Key Characteristics:

a.	 Complexity: A large set of complex instructions.
b.	 Variable Execution Time: Instructions can take multiple clock cycles.
c.	 Single Instruction Operations: Some instructions can perform 

multiple operations.

Example Instructions:

a.	 ADD R1, R2, [R3]
•	 Description: Adds the contents of register R2 and the value at 

memory address specified by R3 and stores the result in register R1.
•	 Operation: R1 = R2 + Memory[R3]
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b.	 MOV [R1], R2
•	 Description: Moves the value from register R2 into the memory 

location specified by R1.
•	 Operation: Memory[R1] = R2

c.	 PUSH R1
•	 Description: Pushes the value from register R1 onto the stack.
•	 Operation: Stack [SP] = R1, SP = SP - 4

d.	 POP R1
•	 Description: Pops a value from the stack into register R1.
•	 Operation: R1 = Stack [SP], SP = SP + 4

Sample Programme:

Objective: Add two numbers stored in memory and store the result in memory.

Instructions:
a.	 MOV R1, [1000] (Load value from memory address 1000 into R1)
b.	 MOV R2, [1004] (Load value from memory address 1004 into R2)
c.	 ADD R3, R1, [1004] (Add R1 and value at address 1004, store result in 

R3)
d.	 MOV [1008], R3 (Store result from R3 into memory address 1008)

Activity 10.3

1.	 Study real-world processors that follow either CISC or RISC principles. 
Examples include Intel x86 (CISC) and ARM (RISC). Analyse their 
instruction sets, performance, and historical context.

2.	 Explore how instructions are encoded in machine code. Compare the length 
of instructions in CISC (often variable-length) and RISC (usually fixed-
length) architectures.

Activity 10.4

1.	 Provide an example of a use case where the read-only nature of ROM is 
essential for a computer system’s functionality.

2.	 Compare and contrast the advantages and disadvantages of using volatile 
RAM versus non-volatile ROM in terms of data storage and accessibility.

3.	 Design a scenario in which a computer system would benefit from having 
both RAM and ROM and describe how each type of memory contributes to 
the system’s functionality.
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Activity 10.5

Topic: Understanding the Differences Between ROM and RAM

Objective: Students will learn about the key differences between ROM and RAM 
through a hands-on activity and discussion.

Materials Needed:

1.	 2 small boxes or containers (one labelled “ROM” and the other “RAM”)
2.	 Small index cards or pieces of paper
3.	 Markers or pens
4.	 A computer or tablet (optional)

Steps:

1.	 Label the two boxes or containers as “ROM” and “RAM.”
2.	 Write the following terms on separate index cards or pieces of paper:

a.	 ROM: Permanent, Read-only, Non-volatile, Stores firmware.
b.	 RAM: Temporary, Read/write, Volatile, Stores data and instructions 

temporarily.

3.	 Form a small group with your classmates
4.	 Work with your group members to sort the cards into the “ROM” or “RAM” 

box based on their characteristics.
5.	 Where two or more group members disagree on a term belonging to a 

particular box, let each member defend his/her stance before the group 
arrives at a box.

6.	 Use the sorted cards to discuss the characteristics of “RAM” and “ROM” as a 
group.

Discussion Questions:

1.	 What are the primary functions of ROM and RAM in a computer?
2.	 Why is ROM considered non-volatile while RAM is volatile?
3.	 How would a computer function differently if it had more RAM but less 

ROM?
4.	 Can you give examples of what might be stored in ROM and what might be 

stored in RAM in your own computer or phone?

Activity 10.6

Evaluate the feasibility and potential challenges of creating a computer 
architecture that blurs the lines between RAM and ROM, aiming to combine the 
benefits of both types of memory. What implications could such an architecture 
have on data storage, data security, and overall system performance?
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Activity 10.7

Case Study on Embedded Systems in Appliances

Objective: You will examine embedded systems in common appliances and 
explore the roles of RAM and ROM in these systems.

Materials:
1.	 Examples of appliances (e.g., microwaves, washing machines)
2.	 Internet access for research
3.	 Case study worksheets

Steps:
1.	 Your teacher will present a case study on how appliances use embedded 

systems (e.g., microwaves with pre-programmed cooking functions).
2.	 Identify the roles of ROM and RAM in these systems (ROM for storing pre-

programmed settings, RAM for handling temporary data like cooking time 
or sensor data).

3.	 Your teacher will assign you into groups to research and create diagrams that 
show the specific use of RAM and ROM in the appliance.

Discussion Questions
1.	 Why is it essential for an appliance’s programme to be stored in ROM?
2.	 What types of temporary data would the appliance store in RAM while it’s 

operating?

Activity 10.8

1.	 In a small group discuss memory access patterns in CISC and RISC 
architectures. Understand how memory hierarchy (cache, RAM, etc.) affects 
performance. Compare load/store instructions in both architectures.

2.	 In your group research emerging trends in processor design, such as ARISK 
(Adaptive Reduced Instruction Set Computer) architectures. Understand 
how ARISK combines features from both CISC and RISC to optimise 
performance1.
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MEMORY ARCHITECTURES OF RAM AND ROM
RAM (Random Access Memory) and ROM (Read-Only Memory) are two essential types 
of computer memory with distinct architectures and functions. Here is a description of 
their memory architectures:

RAM (Random Access Memory)
1.	 Volatility: RAM is volatile memory, which means it loses its data when the power 

is turned off. It stores data temporarily and is used for tasks that require fast read 
and write operations.

2.	 Architecture: RAM is composed of integrated circuits that consist of memory cells. 
Each cell is typically a capacitor and a transistor, with the state of the transistor 
representing the binary value (0 or 1). The data in RAM is stored in a matrix-like 
structure of rows and columns, allowing random access to any memory location.

3.	 Read/Write: RAM is both readable and writable, which means data can be written 
to and read from it. This feature makes it ideal for storing data that needs to be 
frequently accessed and modified during a computer’s operation.

4.	 Speed: RAM is extremely fast and provides quick access to data. It is crucial for 
temporarily holding data that the CPU actively uses while running applications 
and the operating system.

5.	 Capacity: RAM capacity can vary in computers, from a few gigabytes (GB) to 
multiple terabytes (TB) in high-end servers. The capacity and speed of RAM affect 
a computer’s performance.

Example Types: Common types of RAMS include Dynamic RAM (DRAM), Synchronous 
Dynamic RAM (SDRAM), Double Data Rate (DDR) RAM, and more.

ROM (Read-Only Memory)
1.	 Volatility: ROM is non-volatile memory, meaning it retains its data even when the 

power is turned off. It stores permanent data and is primarily used for firmware and 
software that should not be altered.

2.	 Architecture: ROM consists of memory cells that are typically implemented as fuse 
links, diode matrices, or mask-programmable ROM. The data in ROM is embedded 
during manufacturing and cannot be altered by normal computer operations.

3.	 Read-Only: ROM is read-only, meaning it can only be read from, and data cannot 
be written to or modified. This makes it suitable for storing firmware and software 
instructions that are essential for the computer’s operation.

4.	 Speed: ROM is slower than RAM because it is not designed for rapid data access 
or modification. It is primarily used for booting up the computer, storing BIOS 
firmware, and firmware for various hardware components.
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5.	 Capacity: The capacity of the ROM varies depending on its purpose. It can range 
from a few kilobytes (KB) in older systems to several gigabytes (GB) in modern 
systems, especially when referring to forms of flash memory like EEPROM or 
NAND flash.

Example Types: There are several types of ROM, including Mask ROM, PROM 
(Programmable ROM), EPROM (Erasable Programmable ROM), and EEPROM 
(Electrically Erasable Programmable ROM). Flash memory is a type of EEPROM 
commonly used for data storage in modern devices.

Activity 10.9

Video on computer architectures and memory types

Objective: Helping you understand computer architectures and memory types

Video: https://www.youtube.com/watch?v=6_
PHIL4LZEU&list=PLBlnK6fEyqRgLLlzdgiTUKULKJPYc0A4q&index=3

https://www.youtube.com/
watch?v=PujjqfUhtNo&list=PLBlnK6fEyqRgLLlzdgiTUKULKJPYc0A4q&index=4

 

Question

1.	 What are computer architectures?
2.	 What are the types of computer architectures?
3.	 What are computer memory and their types?

https://www.youtube.com/watch?v=6_PHIL4LZEU&list=PLBlnK6fEyqRgLLlzdgiTUKULKJPYc0A4q&index=3
https://www.youtube.com/watch?v=6_PHIL4LZEU&list=PLBlnK6fEyqRgLLlzdgiTUKULKJPYc0A4q&index=3
https://www.youtube.com/watch?v=PujjqfUhtNo&list=PLBlnK6fEyqRgLLlzdgiTUKULKJPYc0A4q&index=4
https://www.youtube.com/watch?v=PujjqfUhtNo&list=PLBlnK6fEyqRgLLlzdgiTUKULKJPYc0A4q&index=4
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 Activity 10.10

Case Study Analysis

Objective: Understand the differences between RAM and ROM memory 
architectures through real-world examples.

Materials: Case study handouts, whiteboard, markers, computer with internet 
access.

Steps:

1.	 Introduction:

a.	 Your teacher will present a brief overview of RAM and ROM memory 
architectures.

b.	 Your teacher will explain the significance of understanding these 
architectures in various technologies.

3.	 Case Study Distribution:

a.	 A case study will be given to you describing different devices that use 
RAM and ROM (e.g., smartphones, computers, embedded systems).

b.	 Each case study should include information about how RAM and ROM 
are utilised in the device.

3.	 Group Work:

a.	 Join a small group with your classmates.
b.	 Read your assigned case study and analyse how RAM and ROM are 

used in the device.

3.	 Presentation: In your group present your findings to the class, highlighting 
the key functions of RAM and ROM in your case study device.

4.	 Discussion: Discuss as a class how RAM and ROM contribute to the 
performance and functionality of the device.

Questions:

1.	 How does RAM contribute to the device’s performance?
2.	 What role does ROM play in the device’s functionality?
3.	 How would the absence of RAM or ROM affect the device’s operation?
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Activity 10.11

Research and Report

Objective: Research and report on the latest advancements in RAM and ROM 
technologies.

Materials: Research materials (books, articles, internet access), report templates.

Steps:
1.	 Research Assignment:

a.	 Research recent advancements in RAM and ROM technologies (e.g., 
DDR5 RAM, NAND flash improvements).

b.	 Your teacher will provide guidelines for credible sources and key topics 
to cover.

2.	 Research Phase: Conduct research individually or in pairs, gathering 
information on the latest advancements and innovations.

3.	 Report Writing: Compile your findings into a report, focusing on the 
technological advancements, applications, and future trends.

4.	 Presentation: Present your reports to the class, using visual aids if 
necessary.

5.	 Class Discussion: Discuss the impact of these advancements on modern 
computing and potential future developments.

Questions
1.	 What are the most recent advancements in RAM and ROM technologies?
2.	 How do these advancements impact the performance and efficiency of 

computing devices?
3.	 What future trends might we expect in RAM and ROM technologies?

Activity 10.12

Classroom Discussion and Debate

Objective: Engage in a discussion and debate on the advantages and limitations 
of RAM and ROM.

Materials: Debate guidelines, discussion prompts, whiteboard, and markers.

Steps:
1.	 Introduction: Your teacher will provide an overview of the advantages and 

limitations of RAM and ROM.
2.	 Discussion:

a.	 Join a classroom discussion on the pros and cons of RAM and ROM. 
b.	 The discussion should include: 

•	 The benefits of having more RAM in a computer 
•	 The limitations of ROM in modern devices
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3.	 Debate Setup: The class will be divided into two teams: one advocating for 
the advantages of RAM and the other for the advantages of ROM.

4.	 Debate:
a.	 Your team should present your arguments and counter the opposing 

team’s points.
b.	 Use evidence from your research and understanding of the technologies.

5.	 Wrap-Up Discussion: Conclude with a class discussion on the key points 
raised during the debate and how RAM and ROM complement each other in 
computing systems.

Questions
1.	 What are the main advantages of RAM in computing systems?
2.	 How does ROM support system functionality in devices?
3.	 What are the limitations of RAM and ROM, and how can they be mitigated?

Activity 10.13

Guest Speaker Session

Objective: Gain insights from an industry expert on RAM and ROM technologies.

Materials: Guest speaker, audio/visual equipment for presentation.

Steps:
1.	 Guest Speaker Invitation: Your teacher will invite an industry professional 

or academic expert who specialises in memory technologies will be invited 
to speak to the class.

2.	 Preparation: Prepare questions related to RAM and ROM technologies in 
advance.

3.	 Guest Speaker Presentation: The guest speaker will present topics related 
to RAM and ROM, including industry trends, challenges, and advancements.

4.	 Q&A Session: Ask your prepared questions and engage in a Q&A session 
with the guest speaker.

5.	 Reflection: Write a brief reflection on what you have learned from the guest 
speaker.

Questions
1.	 What are some current trends in RAM and ROM technologies?
2.	 How are advancements in memory technologies impacting the industry?
3.	 What challenges do engineers face when developing new memory 

technologies?
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Activity 10.14

Case Study Analysis: Mobile Devices

Objective: Analyse how RAM and ROM are utilised in mobile devices.

Materials: Case study handouts (e.g., smartphone specifications), whiteboard, 
markers.

Steps:
1.	 Introduction: The teacher will briefly explain RAM and ROM.
2.	 Case Study Distribution: You will be given a case study describing 

different smartphones and their memory architectures.
3.	 Group Work: Analyse the case study in a group, focusing on the roles of 

RAM and ROM.
4.	 Presentation: In your group present your findings.
5.	 Class Discussion: Discuss how RAM and ROM affect the performance of 

mobile devices.

Questions
1.	 How does RAM contribute to the performance of smartphones?
2.	 What role does ROM play in the device’s functionality?
3.	 How would the performance change if the RAM or ROM were upgraded?

Activity 10.15

The historical development of RAM and ROM 

Objective: Research and present the historical development of RAM and ROM.

Materials: Research materials (books, articles, internet access), report templates.

Steps:
1.	 Research Assignment: Research the evolution of RAM and ROM over the 

decades.
2.	 Research Phase: Gather information individually or in pairs.
3.	 Report Writing: Compile your findings into a report.
4.	 Presentation: Present your findings to the class.
5.	 Discussion: Discuss the impact of these advancements on technology.

Questions
1.	 How has RAM technology evolved over time?
2.	 What were the key milestones in the development of ROM?
3.	 How have these changes impacted modern computing?
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Activity 10.16

Classroom Discussion: RAM vs. ROM

Objective: Compare and contrast RAM and ROM.

Materials: Whiteboard, markers.

Steps:

1.	 Introduction: Your teacher will provide a brief overview of RAM and ROM.
2.	 Discussion Setup: Join a class discussion.
3.	 Group Input: List the advantages and limitations of RAM and ROM.
4.	 Class Discussion: Discuss the differences and applications of each type of 

memory.
5.	 Summarise: Summarise key points on the whiteboard.

Questions
1.	 What are the main differences between RAM and ROM?
2.	 How does the role of RAM differ from that of ROM in a computer system?
3.	 In what scenarios might one be preferred over the other?

Activity 10.17

Debate: RAM and ROM in Future Technologies

Objective: Debate the future importance of RAM and ROM in emerging 
technologies.

Materials: Debate guidelines, discussion prompts.

Steps:

1.	 Topic Assignment: The class will be divided into two teams: one arguing 
for the continued importance of RAM and the other for ROM.

2.	 Preparation: in your team prepare arguments and evidence.
3.	 Debate: Conduct the debate, with each team presenting their case.
4.	 Class Discussion: Discuss the debate outcomes and implications for future 

technologies.

Questions

1.	 Will RAM or ROM be more critical in future computing technologies?
2.	 What emerging technologies might impact the role of RAM and ROM?
3.	 How should the design of RAM and ROM adapt to future needs?
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Activity 10.18

Guest Speaker: Memory Technology Expert

Objective: Gain insights from an industry expert on RAM and ROM technologies.

Materials: Audio/visual equipment, guest speaker.

Steps:

1.	 Invite Expert: Your teacher will arrange for a guest speaker who specialises 
in memory technologies will be invited.

2.	 Preparation: Prepare questions for the guest speaker.
3.	 Guest Speaker Session: The expert will present on RAM and ROM 

technologies.
4.	 Q&A Session: Ask your prepared questions and engage with the speaker.
5.	 Reflection: Write a reflection on the insights gained from the session.

Questions
1.	 What are the current trends in RAM and ROM technologies?
2.	 How do these technologies impact various industries?
3.	 What are the biggest challenges in developing new memory technologies?

Activity 10.19

Hands-On Activity: Build a Simple Memory Model

Objective: Create a physical model to demonstrate how RAM and ROM work.

Materials: Craft supplies, diagrams, example code.

Steps:
1.	 Introduction: Your teacher will explain the basic concepts of RAM and 

ROM.
2.	 Model Creation: Build a simple model using craft supplies to represent 

RAM and ROM.
3.	 Demonstration: Demonstrate how data is stored and accessed in your 

models.
4.	 Class Discussion: Discuss how the models represent real-world memory 

architectures.

Questions
1.	 How does your model represent the function of RAM and ROM?
2.	 What limitations did you encounter in your model?
3.	 How could you improve the model to better reflect actual memory 

architectures?
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Activity 10.20

Research and Report: RAM and ROM in Embedded Systems

Objective: Investigate how RAM and ROM are used in embedded systems.

Materials: Research materials, report templates.

Steps:
1.	 Research Assignment: Research on RAM and ROM usage in various 

embedded systems (e.g., microcontrollers, IoT devices).
2.	 Research Phase: Gather information on specific embedded systems.
3.	 Report Writing: Compile and organise findings into a report.
4.	 Presentation: Present your report to the class.
5.	 Discussion: Discuss the role of RAM and ROM in different embedded 

applications.

Questions
1.	 How is RAM used in embedded systems compared with general-purpose 

computers?
2.	 What are the specific requirements for RAM and ROM in these systems?
3.	 How does the choice of memory affect the performance and functionality of 

embedded devices?

Activity 10.21

Case Study: Computer Systems in Different Environments

Objective: Examine how RAM and ROM are used in different computing 
environments.

Materials: Case study handouts, whiteboard, markers.

Steps:
1.	 Case Study Distribution: Your teacher will provide case studies on various 

computer systems (e.g., desktops, laptops, servers).
2.	 Group AnalysisAnalyse the case studies in groups, focusing on memory 

usage.
3.	 Presentation: In your group present your findings to the class.
4.	 Class Discussion: Discuss the differences in memory usage across different 

systems.

Questions

1.	 How does RAM usage differ between desktops and servers?
2.	 What are the advantages of several types of ROM in various computing 

environments?
3.	 How do these differences impact system performance and reliability?
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Activity 10.22

Interactive Quiz: Memory Architectures

Objective: Test knowledge of RAM and ROM through an interactive quiz.

Materials: Quiz software or printable quiz sheets, answer key.

Steps:
1.	 Quiz Creation: Working in small groups, work together to develop a quiz 

with questions about RAM and ROM.
2.	 Quiz Administration: Conduct the quiz in class, either online or on paper.
3.	 Review: Go over the quiz answers and explanations.
4.	 Discussion: Discuss any misconceptions or challenging concepts.

Questions
1.	 What are the primary functions of RAM and ROM?
2.	 How does the architecture of RAM differ from that of ROM?
3.	 What are common types of RAM and ROM, and their characteristics?

Activity 10.23

Project: Design a Memory System

Objective: Design a simple memory system for a hypothetical device.

Materials: Project guidelines, design tools, presentation materials.

Steps:
1.	 Project Assignment: Design a memory system for a fictional device (e.g., a 

new type of smart gadget).
2.	 Design Phase: Create a detailed design including RAM and ROM 

specifications and their roles.
3.	 Presentation: Present the design to the class, explaining the choices made 

for RAM and ROM.
4.	 Feedback: Provide and receive feedback on your designs.

Questions
1.	 How did you determine the amount of RAM and ROM needed for your 

device?
2.	 What trade-offs did you consider in your design?
3.	 How would different memory choices affect the device’s performance and 

functionality?
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Activity 10.24

1.	 Compare and contrast the primary differences between dynamic RAM 
(DRAM) and static RAM (SRAM) in terms of speed, construction, and usage 
scenarios.

2.	 Imagine you’re designing a high-performance gaming computer. Discuss 
the justification in the choice between using more DRAM or more SRAM in 
the system’s architecture, considering factors such as cost, speed, and power 
consumption.

INSTALLING AND CONFIGURING THE 
ENVIRONMENTAL VARIABLES OF THE ARDUINO
Arduino is an open-source platform that consists of both hardware and software 
components. It was created to provide an easy way for beginners and enthusiasts to 
create interactive electronic projects. The platform includes a range of microcontroller 
boards that can be programmed to perform various tasks, along with an integrated 
development environment (IDE) for writing, compiling, and uploading code to these 
boards.

Microcontrollers and their Applications
Microcontrollers are small, integrated circuits that contain a processor, memory, and 
input/output pins. They are designed to perform specific tasks and are commonly 
used in various applications, such as robotics, automation, home electronics, wearable 
devices, and more. Microcontrollers provide a cost-effective and efficient way to control 
electronic components and devices.

Key Components of Arduino
a.	 Arduino Board: The physical hardware that contains a microcontroller. 

Common boards include Arduino Uno, Arduino Mega, and Arduino Nano.
b.	 Arduino IDE: The software used to write and upload code to the Arduino 

board. It allows users to write programmes in a simplified version of C++ and 
includes libraries to interact with various sensors and components.

c.	 Microcontroller: The “brain” of the Arduino board, responsible for executing 
code and controlling the attached hardware.

d.	 Digital and Analogue I/O Pins: These pins allow the Arduino to interface 
with external components. Digital pins can read or send high or low signals, 
while analogue pins can read varying voltages.

e.	 Power Supply: The Arduino board can be powered through a USB connection 
or an external power source.
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f.	 Libraries: Pre-written code that makes it easier to use various sensors, actuators, 
and other peripherals with the Arduino.

Practical Applications of Arduino
a.	 Educational Projects: Arduino is widely used in educational settings to teach 

students about electronics, programming, and embedded systems.
b.	 Home Automation: It can be used to control home appliances, lighting 

systems, and security systems.
c.	 Robotics: Arduino boards are commonly used in robotics projects to control 

motors, sensors, and other components.
d.	 Environmental Monitoring: Arduino can interface with sensors to monitor 

environmental conditions like temperature, humidity, and air quality.
e.	 Interactive Art: Artists use Arduino to create interactive installations and art 

projects that respond to user input.

Getting Started with Arduino
a.	 Install the Arduino IDE: Download and install the Arduino Integrated 

Development Environment (IDE) from the official Arduino website.
b.	 Connect the Arduino Board: Use a USB cable to connect the Arduino board 

to your computer.
c.	 Write and Upload Code: Write a programme (sketch) using the Arduino IDE 

and upload it to the board. A simple example is the “Blink” sketch, which makes 
an LED on the board blink on and off.

d.	 Explore Projects: Start with basic projects like controlling LEDs, reading sensor 
data, or building simple robots. Gradually move to more complex projects as 
you gain experience.

Installing Arduino IDE:
a.	 Go to the official Arduino website (arduino.cc) and download the Arduino IDE 

suitable for your operating system.
b.	 Run the downloaded installer and follow the on-screen instructions to install 

the Arduino IDE.

Configuring Environmental Variables
Environmental variables are settings that the operating system uses to locate necessary 
files and resources. To set up the necessary environmental variables for Arduino IDE,

a.	 Find the location where Arduino IDE is installed on your computer.
b.	 Copy this path.
c.	 Search for “environmental variables” in your computer’s search bar and select 

“Edit the system environmental variables.”
d.	 Click the “Environment Variables” button.
e.	 Under “System Variables,” find the “Path” variable and click “Edit.”
f.	 Click “New” and paste the path of the Arduino IDE installation folder.
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Connecting Arduino Hardware:
Arduino offers various boards, each with specific features. Common ones include 
Arduino Uno, Arduino Nano, and Arduino Mega. To connect Arduino to your computer:

•	 Plug the Arduino board into your computer using a USB cable.

Uploading Arduino Sketches:
Arduino sketches are programmes written in the Arduino programming language. 
They consist of two essential functions: setup () and loop (). To upload a sketch:

a.	 Write your Arduino sketch in the Arduino IDE.
b.	 Select your Arduino board model under the “Tools” menu.
c.	 Choose the correct port under the “Tools” menu.
d.	 Click the “Upload” button (right arrow icon). The IDE compiles the code and 

uploads it to the Arduino board.

Troubleshooting and Debugging:
Common issues include incorrect drivers, port selection, or syntax errors. Read error 
messages carefully and search online forums for solutions. Use resources like Arduino’s 
official website, forums, and tutorials to find solutions.

Exploring Arduino Libraries and Examples:
Libraries are pre-written code snippets that extend Arduino’s functionality. To use 
them:

In the IDE, go to “Sketch”> “Include Library” to include a library in your sketch.
To use examples, go to “File”> “Examples” to access a variety of pre-built sketches.

Activity 10.25

Arduino IDE Installation and Setup

Objective: Install the Arduino IDE and configure environmental variables.

Materials: Computers with internet access, USB drives, Arduino IDE installation 
files.

Steps:

1.	 Download: Download the Arduino IDE from the official website.
2.	 Install: Install the IDE on each student’s computer.
3.	 Configure: Set up environmental variables if needed (e.g., adding the 

Arduino path to system PATH on Windows).
4.	 Test: Open the IDE and verify installation by compiling a basic example 

sketch.
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Questions
1.	 How do you check if the Arduino IDE is correctly installed?
2.	 What are the steps to set up environmental variables on your system?

Activity 10.26

Basic Arduino Sketch Upload

Objective: Interface with Arduino hardware by uploading a basic sketch.

Materials: Arduino boards, USB cables, computers with Arduino IDE.

Steps:
1.	 Connect: Connect the Arduino board to the computer via USB.
2.	 Select Board and Port: In the Arduino IDE, select the correct board type 

and port.
3.	 Upload Sketch: Open the “Blink” example sketch and upload it to the 

Arduino.
4.	 Observe: Observe the onboard LED blinking.

Questions
1.	 How do you select the correct board and port in the Arduino IDE?
2.	 What does the “Blink” sketch do, and how can you modify it?

Activity 10.27

Devise a comprehensive guide detailing advanced techniques for optimising 
the interaction between the Arduino IDE and hardware. Include methods to 
streamline the configuration of environmental variables, troubleshoot common 
issues, and ensure efficient code uploading and execution.

Activity 10.28

Environmental Variable Configuration Game

Objective: Learn environmental variables through a role-playing game.

Materials: Role cards, computers.

Steps:
1.	 Assign Roles: Your teacher will assign you to a role (e.g., “System 

Administrator,” “User,” “IDE”).
2.	 Scenario: You will be given a scenario where you must configure and 

troubleshoot environmental variables.
3.	 Role-Play: Act out your role and solve configuration issues.
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Questions
1.	 What are common issues you might face when configuring environmental 

variables?
2.	 How can these issues be resolved?
3.	 Assess the implications of relying solely on default settings and not 

configuring environmental variables when using the Arduino IDE. 
4.	 Analyse potential drawbacks in terms of performance, compatibility, and 

development workflow.

Activity 10.29

Arduino IDE Customisation Challenge

Objective: Customise the Arduino IDE to enhance usability.

Materials: Computers with Arduino IDE.

Steps:
1.	 Explore Settings: Explore the IDE’s preferences and settings.
2.	 Customise: Change themes, fonts, or other settings to customise the IDE.
3.	 Share: Share customisations with your class and explain the reasons behind 

them.

Questions
1.	 What customisation options are available in the Arduino IDE?
2.	 How can customising the IDE improve your programming experience?

Activity 10.30

Hands-On Sensor Interface

Objective: Interface with a sensor using Arduino and the IDE.

Materials: Arduino boards, sensors (e.g., temperature, light), computers, jumper 
wires.

Steps:

1.	 Connect Sensor: Connect a sensor to the Arduino board.
2.	 Write Code: Write a sketch to read data from the sensor.
3.	 Upload and Test: Upload the sketch and monitor the sensor data on the 

serial monitor.

Questions
1.	 How do you interface a sensor with the Arduino board?
2.	 What does the code do to read data from the sensor?
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Activity 10.31

Serial Monitor Game

Objective: Use the Arduino serial monitor effectively through a game.

Materials: Computers with Arduino IDE, Arduino boards.

Steps:
1.	 Code Challenge: Write a sketch that outputs data to the serial monitor.
2.	 Monitor Game: Compete with your classmates to correctly interpret data 

from the serial monitor.
3.	 Discuss: Discuss the purpose and use of the serial monitor in debugging.

Questions
1.	 How can the serial monitor help in debugging your code?
2.	 What types of data can you view using the serial monitor?

Activity 10.32

Create a Simple Arduino Project

Objective: Build and programme a simple project using Arduino.

Materials: Arduino boards, LEDs, resistors, breadboards, jumper wires, 
computers.

Steps:

1.	 Design: Design a simple project (e.g., traffic light).
2.	 Assemble: Assemble the project on a breadboard.
3.	 Programme: Write and upload a sketch to control the project.
4.	 Test: Test and debug the project.

Questions
1.	 What are the basic components required for your project?
2.	 How does your code control the project?
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Activity 10.33

Arduino IDE Debugging Simulation

Objective: Simulate debugging issues with Arduino IDE.

Materials: Computers with Arduino IDE.

Steps:
1.	 Simulate Errors: Your teacher will have created some common coding 

errors or configuration issues.
2.	 Debug: Identify and fix the errors.
3.	 Discuss: Discuss common debugging strategies and tools.

Questions
1.	 What types of errors might you encounter when using the Arduino IDE?
2.	 How can you use debugging tools to resolve these errors?

Activity 10.34

Arduino Library Exploration

Objective: Explore and use Arduino libraries.

Materials: Computers with Arduino IDE.

Steps:
1.	 Library Search: Search for and install a library from the Arduino Library 

Manager.
2.	 Use Example Code: Use the example code provided by the library.
3.	 Modify Code: Modify the example code to experiment with library 

functions.

Questions
1.	 How do you find and install libraries in the Arduino IDE?
2.	 How do libraries simplify coding with Arduino?
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Activity 10.35

Create and Upload a Custom Arduino Sketch

Objective: Develop and upload a custom sketch to Arduino.

Materials: Arduino boards, computers with Arduino IDE.

Steps:
1.	 Write Sketch: Write a custom sketch for a specific task (e.g., controlling 

multiple LEDs).
2.	 Upload: Upload the sketch to the Arduino board.
3.	 Test: Test the functionality of your custom sketch.

Questions
1.	 What is the purpose of your custom sketch?
2.	 How does your code achieve this purpose?
3.	 Design a flowchart illustrating the sequence of events that occur from 

writing Arduino code in the IDE to uploading and executing it on the 
connected Arduino board. 

4.	 Highlight the role of environmental variables in this process.

Activity 10.36

Arduino IDE Troubleshooting Challenge

Objective: Troubleshoot common issues with the Arduino IDE.

Materials: Computers with Arduino IDE.

Steps:
1.	 Issue Creation: Your teacher will have created some common IDE issues 

(e.g., port not found, compilation errors).
2.	 Troubleshoot: Identify and resolve the issues.
3.	 Share Solutions: Share solutions with your classmates and discuss.

Questions
1.	 What common issues might occur with the Arduino IDE?
2.	 How can you troubleshoot and resolve these issues?
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Activity 10.37

Arduino Hardware and IDE Integration Quiz

Objective: Test understanding of Arduino hardware and IDE integration through 
a quiz.

Materials: Quiz questions, computers with Arduino IDE.

Steps:
1.	 Prepare Quiz: Your teacher will have created a quiz covering installation, 

configuration, and interfacing.
2.	 Take Quiz: Take the quiz individually or in groups.
3.	 Review: Review answers with your teacher and discuss common 

misconceptions.

Questions
1.	 What are the steps to configure environmental variables for the Arduino 

IDE?
2.	 How do you select the correct board and port in the Arduino IDE?

Activity 10.38

Watch videos of Arduino IDE and how it functions

Objective: Understand Arduino IDE and how it functions.

Video link: https://youtu.be/CSx6k-zXlLE

Questions

1.	 What is Arduino IDE?
2.	 What are the functions of Arduino IDE?

Activity 10.39

Create a video or presentation demonstrating the installation, environmental 
variable configuration, and successful interface setup between the Arduino 
IDE and Arduino hardware. Incorporate demonstrations, explanations, and 
troubleshooting tips.

https://youtu.be/CSx6k-zXlLE
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Review Questions

1.	 What is the primary difference between CISC and RISC architectures?

2.	 Why are RISC architectures typically faster than CISC architectures for specific 
tasks?

3.	 Describe how memory access differs between CISC and RISC architectures.

4.	 What is ARISC architecture, and how does it differ from RISC?

5.	 Give an example of an application where CISC architecture might be more 
suitable than RISC. Why?

6.	 Why are RISC-based processors commonly used in mobile and embedded 
systems?

7.	 Why is RAM necessary for running applications on a computer?

8.	 How is ROM used in a smartphone when the device is powered on?

9.	 What would happen if a computer had no RAM but only ROM?

10.In gaming consoles, how does RAM improve the gaming experience?

11.Why do embedded systems like microwaves or printers use ROM instead of 
RAM to store their instructions?

12.Can a computer function if it only has RAM and no ROM? Explain.

13.What is the primary difference between the architecture of RAM and ROM?

14.Why is RAM referred to as “random access” memory?

15.Explain the architecture of Static RAM (SRAM) and Dynamic RAM (DRAM). 
How are they different?

16.How does ROM architecture ensure that data is retained even after power is 
lost?

17.Why is RAM critical for multitasking in computers, and how does its 
architecture support this?

18.How is the data stored in ROM different from the data stored in RAM, in terms 
of usage and architecture?

19.What are the basic steps to install the Arduino IDE on your computer?

20.What are environmental variables, and why are they important when using 
the Arduino IDE?

21.How do you configure the Arduino IDE to communicate with an Arduino 
board?

22.What might cause the Arduino IDE to fail to recognise your Arduino board, 
and how would you troubleshoot it?
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23.How do you set environmental variables for accessing Arduino libraries and 
custom hardware configurations?

24.How can you verify that your Arduino IDE and hardware are properly 
configured and working?
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Answers to Review Questions

1.	 The primary difference lies in their instruction sets:
CISC (Complex Instruction Set Computer) uses a large set of complex 
instructions, where one instruction can execute multiple operations (like 
loading data, performing an operation, and storing the result).

RISC (Reduced Instruction Set Computer) uses a smaller set of simpler 
instructions that are typically executed in a single clock cycle, with each 
instruction performing a basic operation (like loading, storing, or performing 
arithmetic).

2.	 RISC architectures are faster for certain tasks because:
RISC uses simpler instructions that are executed in one clock cycle, which 
leads to faster instruction execution.

The streamlined instruction set allows RISC processors to be more efficient 
in pipelining, where multiple instructions are processed simultaneously at 
different stages.

3.	 In CISC, instructions can directly operate on data in memory, meaning it can 
perform operations like loading data from memory and manipulating it in one 
instruction.
In RISC, instructions follow a load/store model where only specific instructions 
(load and store) can access memory, and all operations must be performed on 
registers (the data must first be loaded from memory to a register before being 
manipulated).

4.	 ARISC (Advanced Reduced Instruction Set Computer) is a variant of RISC 
architecture that adds optimisations for specific applications. It builds on the 
simplicity of RISC but may include additional features like:
Advanced power management to make the system more energy-efficient.

Enhanced support for parallel processing or real-time processing. ARISC still 
maintains the core principles of RISC but is designed for more specialised 
tasks, such as mobile or embedded systems, where power efficiency and real-
time performance are critical.

5.	 CISC architecture might be more suitable for desktop computers or legacy 
systems that require backward compatibility with older software. Since CISC 
can perform more complex instructions, it is more efficient in handling software 
that was originally written for CISC processors, as rewriting or optimising that 
software for RISC would be difficult or inefficient.

6.	 RISC-based processors are favoured in mobile and embedded systems because:
Energy efficiency: The simpler instruction set of RISC allows for lower power 
consumption, which is crucial for battery-powered devices.
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Performance: RISC’s efficient pipelining and faster instruction execution 
improve performance for the types of applications commonly run on mobile 
and embedded systems, such as real-time operations and multitasking.

7.	 RAM (Random Access Memory) is necessary because it provides temporary 
storage for data and instructions that the CPU needs while running applications. 
Since RAM is much faster than storage devices like hard drives or SSDs, it 
allows the CPU to quickly access the data required for active tasks, improving 
the overall speed and responsiveness of a system.

8.	 ROM (Read-Only Memory) in a smartphone contains the firmware or operating 
system essential for booting the device. When the smartphone is powered on, 
the data in ROM is read to initialise hardware components, load the operating 
system, and get the phone ready for use. This is a crucial function because 
ROM retains data even when the power is off.

9.	 If a computer had no RAM and only ROM, it could boot and perform some 
basic initialisation tasks (since ROM stores the firmware). However, it wouldn’t 
be able to run any applications or perform complex tasks. This is because RAM 
is required for storing active programme data and instructions, whereas ROM 
is non-volatile and cannot be used for real-time processing.

10.In gaming consoles, RAM improves the gaming experience by storing game 
data that needs to be accessed quickly, such as textures, game states, and active 
processes. This reduces loading times and ensures smooth gameplay. The 
faster the RAM, the more efficiently the game can render complex graphics 
and handle real-time interactions, enhancing the overall performance.

11.Embedded systems use ROM to store instructions because ROM is non-volatile, 
meaning it retains data even when the device is powered off. These systems 
need permanent storage for their basic operational instructions (firmware), 
such as controlling heating cycles in a microwave or printing mechanisms in 
a printer. RAM would not be suitable for this purpose as it would lose the data 
once the device is turned off.

12.No, a computer cannot function without ROM. ROM is essential for storing 
the Basic Input/Output System (BIOS) or UEFI firmware, which initialises 
the hardware and boots the operating system. Without ROM, the computer 
wouldn’t know how to start the boot process, leaving the system non-functional. 
RAM alone cannot perform this task since it is volatile and doesn’t retain data 
when the power is off.

13.The primary difference is that RAM (Random Access Memory) is volatile, 
meaning it temporarily stores data and loses it when the power is turned off. 
It allows both read and write operations, meaning data can be written to and 
read from RAM quickly.
In contrast, ROM (Read-Only Memory) is non-volatile, meaning it retains 
data even when the power is off. ROM is designed primarily for read-only 
operations; data is pre-written during manufacturing or programming and 
cannot be easily modified or erased.
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14.RAM is referred to as “random access” because the CPU can access any 
memory location directly and in any order without having to go through other 
memory locations first. This makes data retrieval fast and efficient compared 
with sequential access storage, like hard drives or tapes, where data must be 
accessed in a specific order.

15.SRAM (Static RAM) uses flip-flop circuits to store each bit of data, which 
makes it faster and more reliable but also more expensive and power-hungry. 
It does not need to be refreshed like DRAM.

DRAM (Dynamic RAM) stores each bit of data in a capacitor and requires 
constant refreshing to retain data. While slower than SRAM, it is more power-
efficient and cost-effective and can store more data per unit of space, making 
it more common in main memory (e.g., computer RAM).

16.ROM is built using non-volatile memory architecture, which relies on specific 
types of circuits that do not need a continuous power supply to retain data. 
Examples include:

PROM (Programmable ROM) stores data via permanently fused connections.

EPROM (Erasable Programmable ROM) can be rewritten but still retains data 
when powered off by using special transistor structures that store charge. 
These designs ensure that the stored data is preserved, even without power.

17.RAM is critical for multitasking because its architecture allows fast, temporary 
storage of the data and instructions required by different applications running 
simultaneously. Its random-access nature means the CPU can quickly switch 
between tasks, retrieving and processing data from multiple programmes 
without significant delays. More RAM allows the computer to handle tasks 
more efficiently by holding more active programmes in memory at once.

18.The data stored in ROM is typically permanent and related to essential system 
functions, like boot instructions or firmware, which do not change frequently. 
ROM is designed for read-only operations, meaning the architecture is 
optimised to preserve and protect critical data from being altered or lost. In 
contrast, the data stored in RAM is temporary and used for the execution of 
active applications and processes. RAM’s architecture is optimised for speed 
and dynamic data handling, allowing frequent read and write operations for 
running software.

19.	
a.	 Download the Arduino IDE from the official Arduino website (https://

www.arduino.cc/en/software) based on your operating system (Windows, 
macOS, Linux).

b.	 Run the installer and follow the on-screen instructions to install the 
software. Ensure you allow the installation of the necessary drivers.

c.	 Once installed, launch the Arduino IDE and check that it opens without 
errors.

https://www.arduino.cc/en/software
https://www.arduino.cc/en/software
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20.Environmental variables are system settings that define the paths and 
configurations the system uses to find and run programmes. For the Arduino 
IDE, they ensure the system knows where the necessary files and libraries are 
located and how to communicate with connected hardware (like the Arduino 
board). They are important because improper configuration can prevent the 
IDE from finding the necessary files or accessing the Arduino hardware.

21.	
a.	 Connect the Arduino board to your computer using a USB cable.
b.	 In the Arduino IDE, go to Tools > Board and select the correct model of 

your Arduino board (e.g., Arduino Uno, Arduino Nano).
c.	 Then go to Tools > Port and select the correct COM port that corresponds 

to your Arduino board (this is usually labelled with the board name).
d.	 Optionally, go to Tools > Programmer and ensure the correct programmer 

is selected (usually “AVRISP mkII” for most Arduino boards).

22.The IDE may fail to recognise the Arduino board due to:

a.	 Incorrect USB cable: Ensure you are using a data cable, not a charge-only 
cable.

b.	 Wrong COM port: Check if the correct COM port is selected under Tools > 
Port.

c.	 Missing drivers: Ensure you have installed the necessary drivers during the 
IDE installation.

d.	 Loose connection: Verify the USB connection is secure between the board 
and the computer.

Troubleshooting steps include:
a.	 Reconnecting the board.
b.	 Trying a different USB port or cable.
c.	 Reinstalling the Arduino IDE or drivers.
d.	 Restarting the computer.

23.	
a.	 Find the Arduino sketchbook location by going to File > Preferences in 

the Arduino IDE. This is the directory where your custom libraries and 
projects are stored.

b.	 To set environmental variables manually, you can modify the system’s 
PATH variable to include the directory paths for your Arduino libraries or 
toolchain (if needed).

c.	 On Windows: Right-click This PC > Properties > Advanced system settings 
> Environment Variables. Then add the directory path to Path under 
System variables.

d.	 On macOS/Linux: Modify the .bashrc or .bash_profile file to include the 
necessary export commands for the paths.
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24.	
a.	 Connect your Arduino board to your computer via USB.
b.	 Open the Arduino IDE and select the correct board and COM port under 

the Tools menu.
c.	 Go to File > Examples > Basics > Blink to load a simple Blink example 

code.
d.	 Click Upload to upload the code to the Arduino board.
e.	 If the onboard LED starts blinking, the IDE and hardware are properly 

configured.
•	 If the upload fails, check for error messages in the IDE’s output window 

to troubleshoot.
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Extended Reading
•	 Malik, S., Hussain, W., Sheikh, A. A., 2015, Comparison of RISC and CISC Architectures, 

International Journal of Scientific and Engineering Research
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